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Welcome to Minute Minder       1 
 
 
 
 
 
 
 

 
This chapter briefly describes Minute Minder and outlines the contents and the 
intended audience of this guide.  Product registration and technical support 
information is also included, along with a brief description of the document 
conventions used within this guide. 
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What is Minute Minder? 
Let me start by asking two questions: 
 
Question 1 
Ever attended a meeting and been coerced into taking the meeting minutes?  Not being prepared you 
reach for the nearest scrap of paper or borrow some sheets from a colleague.  After leaving the 
meeting with pages of notes do you then spend the next hour or so typing these minutes into a 
formatted document? 
 
Question 2 
Ever attended a meeting where not everyone is clear of the purpose of the meeting, what the agenda 
of the meeting is and who is attending the meeting.  Ever left these meetings feeling that nothing was 
decided or even feeling more confused than when you went in? 
 
While not a betting person I would lay good odds that you said yes to at least one of these questions. 
 
Congratulations in purchasing Raspberry Software’s Minute Minder.  Minute Minder has been 
designed by engineers who have worked in large companies and are no strangers to attending meetings 
with the qualities described by the two questions above. 

Who should use this guide? 
This guide is intended for complete novices of Minute Minder.  While this document will guide you 
through the installation process it is assumed that the user is familiar with the basic navigation of their 
mobile device. 
 
The guide has been created as a reference guide whereby usability is described step-by-step by visiting 
the appropriate chapter. 

Minute Minder Functionality 
Minute Minder helps you manage all activities associated with arranging a meeting, minuting the 
meeting and publishing the meeting minutes.  Features of the application include: 
 
Pre-Meeting Activities 

• Gather Attendee information using the Contacts on your mobile device. 
• Determine a date and time for your meeting. 
• Create an agenda for a meeting associating sequencing, times and owners for each agenda item. 
• Sending calendar invites to all those invited to the meeting attaching to the invitation the 

detailed agenda you created via Minute Minder. 
 
Meeting Activities 

• Using your mobile device to easily record minutes of the meeting using the input methods 
supported by your mobile device. 

- 6 - 



Minute Minder 

• Easily associating minute notes taken with who contributed to them and to what agenda items 
they relate to. 

• Easily navigating through notes already taken to add or amend notes or read back what was 
said at any one time. 

• Automatically associating reference numbers to the notes taken and durations of how long a 
topic was discussed.  

• Automatically time stamping minuted agenda items in order to profile where time has been 
spent during the meeting.  

 
Post-Meeting Activities 

• Previewing the notes taken in the meeting making amendments where necessary. 
• Automatically generating formatted minutes which will be sent to all those who attended the 

meeting via the Microsoft Outlook Calendar using an RFT formatted attachment. 
• Providing a mechanism for generating customized formatted minutes using user generated 

output templates. 
 

Within a short space of time you will not only be more organised within meetings but your colleagues 
will be better informed as to the purpose of the meeting and the decisions and actions that resulted of 
your meetings.  
 
You will soon start to wonder how you managed before Minute Minder! 

Technical Support & Additional Information 
While every effort has been made to ensure the product is as intuitive as possible we recognise that 
from time to time questions will need to be answered about Minute Minder.  At Raspberry Software 
we see every item of feedback as an opportunity to improve our products and therefore welcome any 
emails regarding Minute Minder or any of our services. 
 
Should you have a technical question regarding Minute Minder please email: 
support@raspberrysoftware.com 
 
Should you require some general information regarding Minute Minder or any of Raspberry Software's 
products then please email: 
info@raspberrysoftware.com
 
Should you wish to provide us with some general feedback on any aspect of Raspberry Software 
activities then please email: 
feedback@raspberrysoftware.com
 
A Minute Minder forum has been created whereby users of Minute Minder can share their experiences 
of using the product.  Forums can be visited using: 
http://www.raspberrysoftware.com/forums/
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Future Development 
If you have an idea for an application for a mobile device but have no sponsor to turn the vision into 
reality, then email: 
 
feedback@raspberrysoftware.com
 
for a no-obligation non-disclosure discussion. 

Document conventions 
This guide uses the following conventions: 
• Commands and buttons 

For easy recognition within procedures, User Interface (UI) features appear in bold type. For 
example: On the File menu, click New. 

• Monospaced font indicates data that you enter using your mobile device. For example:  
 

In the Meeting Title enter: 
 

Project Update Meeting 

• Information that the user is requested to make special note of is marked with a symbol.  
For example: 

 

 The date format that dates will be displayed in are controlled by the  
default date format set for you mobile device. 

 
• In order to use this User Guide as a reference manual, specific aspects of the applications 

step-by-step instructions are provided in the following style to allow quick scanning of the 
document.  For example: 
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The Start and Finish time, and Date of the meeting are 
entered as follows: 

 

1. Select the start time by altering the hour, minutes, 
seconds and AM/PM elements of the Start time. 

2.  Select the date you wish to hold the meeting by 
changing the date elements of the Date field or use 
the dropdown calendar control to select a date. 

3. Select the start time by altering the hour, minutes, 
seconds and AM/PM elements of the Finish time. 
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Installation            2 
 
 
 
 
 
 
 

 
This chapter describes the process by which you install and uninstall Minute Minder 
to your mobile device.  In addition this chapter provides some details on 
troubleshooting the installation process. 
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Prerequisites 
Before you install Minute Minder you need to ensure the following: 
 

1. You are installing to the PocketPC (PPC 2002 or PPC 2003) Operating System.  At this time 
no other mobile devices are supported by Minute Minder. 

 
2. You have ActiveSync installed and your Mobile Device is connected to the PC you are 

installing Minute Minder from. 
 

3. You have the necessary installation files located within the same directory: 
• Setup.exe 
• Minuteminder.cab 
• Minuteminder.dat 
• Minuteminder.ini 

4. You have removed any previous version of Minute Minder from your mobile device.  Refer to 
Uninstalling Minute Minder.  

 
If all the above conditions have been satisfied you are ready to install Minute Minder. 

Installing Minute Minder 
To install Minute Minder on your mobile device:  

1. Double click Setup.exe.  The following Dialog will be presented. 
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2. Click Next to continue with the installation (Cancel will abort the installation). 

 
3. Read the License text fully.  If you agree with the conditions within the License Agreement select 

the “I accept the terms in the License Agreement” checkbox and then press Next. 
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4. Now press Install.  

 
5. The installation will now invoke the ActiveSync Application Manager.  The Application Manager 

manages the installing and removing of programs from your mobile device.  Once prompted to 
install Minute Minder select Yes. 

 
6. All the necessary files will be transferred from your PC and installed onto your Mobile Device. 
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7. You will notice that your mobile device will display a progress bar as the install progresses.  Simply 
click OK to the above dialog, ActiveSync will and close return control the Minute Minder Installer. 

 
8. Select Register… to register with Raspberry software as a user of Minute Minder.  Registering will 

provide support for the product and provide notifications of new versions/patches of the Minute 
Minder product.  It is strongly recommended you Register Minute Minder.  Once you have 
Registered select Finish to close the installer.   

9. To run Minute Minder select Programs from the Start Menu on your mobile device and run 
Minute Minder. 
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Uninstalling Minute Minder 
 

To Uninstall Minute Minder from you Mobile device: 
 

1. Using ActiveSync with your mobile device connected, select Add/Remove Programs from the 
Tools menu. 

 
2. A dialog will be presented displaying a list of all the applications installed on your mobile device. 
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3. Select Raspberry Software Minute Minder from the list and then press Remove… 

 
4. A prompt will be displayed to confirm that you wish to remove Minute Minder from your mobile 

device and your desktop PC.  Select OK if you wish to proceed with the uninstall. 
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5. Once uninstalled you will be returned to the Add/Remove programs screen.  All Minute Minder 

application files and shortcuts will have been removed from your mobile device.  Minute Minder 
will no longer appear in the installed programs list.  Press OK to close the dialog. 
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Installation Troubleshooting 
 
The following provides a series of questions and answers that should address any issues you encounter 
within the installation process.    Should your question not be answered below then please email your 
query to support@raspberrysoftware.com
 
Q1. I receive an error message “Error: Unable to locate ActiveSync (CEAPPMGE.EXE) within 
registry.  Unable to proceed with install.” 
 
A1.  The ActiveSync executable CEAPPMGE.EXE is invoked by the Minute Minder installer to 
manage the installation process onto your mobile device.  The location of CEAPPMGE.EXE is 
determined by a registry lookup of: 
 
HKLM\software\Microsoft\Windows\CurrentVersion\App Paths\CEAppMgr.EXE.    
 
This registry key is created as part of the ActiveSync installation process.  There may be a problem 
with the ActiveSync installation.  Uninstall and then reinstall ActiveSync. 
 
 
Q2.  I receive an error message:  
“Error: Unable to locate all the files necessary to complete the installation of Minute Minder. 
 
The missing file(s) is: 
CEAPPMGE.EXE.  This is usually located within C:\Program Files\Microsoft\Activesync\ 
…” 
  
A2.  The ActiveSync executable CEAPPMGE.EXE cannot be found in the location identified by 
registry setting: 
 
HKLM\software\Microsoft\Windows\CurrentVersion\App Paths\CEAppMgr.EXE   
 
This executable is created as part of the ActiveSync installation process.  There may be a problem with 
the ActiveSync installation.  Uninstall and then reinstall ActiveSync. 
 
 
Q3. What files are installed on my mobile device? 
 
A3.  The following files are installed on your mobile device as part on the installation process: 
 
Files: 
My Device\Program Files\Raspberry Software\Minute Minder\Minute Minder.exe 
My Device\Program Files\Raspberry Software\Minute Minder\Templates\standard.rtf 
 
Shortcuts: 
My Device\Windows\Start Menu\Programs\Minute Minder  <-maps to-> Minute Minder.exe above. 
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License Key 
Minute Minder is protected by a License key.  Once installed the product will be useable for 14 days 
without a license key being entered into the product.  This time period provides a “try before you buy” 
trial period. 
 
Once the time period has expired a valid license key will need to be entered into Minute Minder.  Your 
license key may be provided with the download of the product, if this is not the case please contact the 
supplier of Minute Minder. 
 
The license key should be entered using the Help - About menu option.  
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Application Overview         3 

 
 
 
 
 
 
 

 
This chapter provides an overview of the general layout of Minute Minder.  
Specifically it will provide an overview of the features available and a general 
overview of how you access these features via the application. 
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Starting Minute Minder 
Once installed, Minute Minder can be started from the Start menu via Programs.   

 

    
 

Minute Minder File List 
Once started a list of previously stored meetings will be presented.  If entering the application for the 
first time the list of files will be blank. 
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By default, all Minute Minder saved files are displayed in the file list, however, the contents for specific 
folders can be displayed by using the All Folders dropdown and selecting an alternative folder.   
 

 
 

The files within the list can be manipulated by clicking holding on a specific file.  The following menu 
will be displayed. 
 

 
 
Create Copy  is a useful option if you wish to create a new meeting based on a previous meeting.  For 
example you may have a meeting that has the same Attendees, by copying the existing meeting file to a 
new meeting then this provides a starting point in creating a new meeting. 
 
Delete permanently removes the file from your mobile device.   This operation is irreversible. 
 
Select All highlights all files in the list.  Actions on click and holding (such as Delete) will apply to all 
files. 
 
Send via E-mail attaches the file to an email in order to send the Minute Minder file to a friend or 
colleague.   
 

 These files are unique to Minute Minder and will not be viewable outside Minute 
Minder. 

 
Beam File provides a facility to send the selected file via infra-red to another mobile device.  Please 
refer to the note above. 
 
Rename/Move opens another dialog allowing the user to rename the file and/or move it to another 
location.  
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Editing or Creating a Meeting 
Previous meetings can be edited by simply clicking on one of the files in the file list.  Alternatively if 
you wish to create a new meeting select New from the menu bar. 
 

Minute Minder Application Map 
The following provides an overview of the functionality provided by Minute Minder, it details the 
functionality provided by each Minute Minder option as well as the menus available for each option. 
 
Minute Minder 
Option 

 
Able to Access Functionality 

 
How? 

File List Screen Setup Meeting dialog (New) 
 
Setup Meeting dialog (Edit exiting meeting) 
 
Import the next or current meeting from your 
Calendar. 
 
Change Minute Minder Options. 
 
 
View Minute Minder version number and view or 
enter a License Key. 
 
Manipulate existing Minute Minder Files. 
 
 
 
Navigate existing folder structures. 
 

New  from the menu bar 
 
Select a file from the file list. 
 
Tools – Quick Import from 
the menu bar. 
 
Tools – Options… from 
the menu bar. 
 
Help – About… from the 
menu bar 
 
Click and Hold on an 
existing file to present a 
menu of choices. 
 
Select the Folders dropdown 
list. 

Setup Meeting 
(New/Edit) 
 

Set/Edit the Title for your meeting 
 
Set/Edit the Meeting Start/End time and date 
using Meeting Time dialog.  
 
Choose/Edit Attendees for the meeting using 
Attendees dialog. 
 
Set/Edit the Agenda using Agenda dialog. 
 
Send meeting invite using Calendar invite to 
selected attendees.  (Only available after meeting 
title, time, attendees and agenda items have been 
created via Meeting Setup dialog)  
 

Use the meeting title field. 
 
Use the Set… button. 
 
 
Use the Choose… button. 
 
 
Use the Set… button. 
 
Tools – Book from the 
menu bar. 
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Record minutes against the meeting created.  
(Only available after meeting title, time, attendees 
and agenda items have been created via Setup 
Meeting dialog)  
 
Distribute formatted minutes of a recorded 
meeting to those who attended the meeting.  
(Only available after meeting has been created 
and minutes recorded.)  
 
Change Minute Minder Options. 
 
 
View Minute Minder version number and link to 
Raspberry Software web site. 
 

Tools – Minute… from the 
menu bar. 
 
 
 
Tools – Distribute from the 
menu bar. 
 
 
 
Tools – Options… from 
the menu bar. 
 
Help – About… from the 
menu bar. 

Book Meeting 
via Calendar 
Invite. 

Send a Calendar invite to all invitees of a 
previously created meeting. 

Tools – Book from the 
menu bar from the Setup 
Meeting dialog. 

Minute Meeting Create a New minute note. 
 
Select Agenda Item to record Minute notes 
against. 
 
 
Select Contributor to record Minutes against. 
 
 
Select Agenda Type to record Minutes against. 
 
 
Record the text associated with a minuted note. 
 
 
Choose a Due date a minuted item should be 
complete by.  (Only available for Minutes notes 
with a type of ACTION.) 
 
Navigate to another agenda item. 
 
 
Manipulate the minuted text (Copy, Cut, Paste 
etc.)  

Use the New button.  
 
Use the Agenda Item 
dropdown list. 
 
 
Use the Contributor 
dropdown list. 
 
Use the Type dropdown list. 
 
 
Use the text box below the 
navigation buttons. 
 
Use the Due button. 
 
 
 
Use the various arrow 
navigation buttons. 
 
Use the Edit menu on the 
menu bar. 
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Distribute 
Formatted 
Minutes to All 
Attendees of the 
meeting. 

Using the minutes previously recorded, 
automatically format the minutes using the 
Template selected within Tools Options… to all 
attendees of the meeting. 

Tools – Distribute from the 
menu bar the Setup Meeting 
dialog. 

Set Minute 
Minder 
Preferences 

Set the preferred output type of formatted 
minutes. 
 
Select a preferred template the formatted minutes 
will adhere to.  (Only available if outputting in 
RTF format only). 

Tools – Options… from 
the menu bar. 
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Creating A Meeting         4 
 
 
 
 
 
 
 

 
This chapter guides you through the process of creating a new meeting.  Specifically 
the chapter will guide you through creating a name for a meeting, setting a date and 
time, choosing mandatory and optional attendees and creating agenda items for the 
meeting. 
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Creating a Meeting 
In this chapter we will create a new meeting to review the project your team is currently working on.  
After launching Minute Minder you will be presented with the following dialog.  This dialog will 
contain no meeting files if you have not previously created meetings with Minute Minder. 
 

  
 
From the file list we can either edit a previously created meeting by clicking on one of the files or 
create a new meeting by selecting New from the menu bar.  As we are creating a new meeting we will 
select New which will present the following dialog. 
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 If the meeting you are taking minutes on has already been sent as a calendar invite 
external to Minute Minder, Minute Minder can import this meeting and thus creating 
many of the elements of Meeting Setup such as meeting title, attendees and date and 
time.  Refer to chapter Quick Import. 

 
 
Within the dialog we can choose a title for our meeting, select a date/time for the meeting, choose 
mandatory and optional attendees for the meeting and finally construct an agenda for our meeting.   

Meeting Title 
The Enter a title for this meeting: allows us to create a subject for our meeting.   The title you 
choose here will appear in the Subject field of the Microsoft Outlook Calendar invite and is therefore 
an important field for your audience to get a first understanding of the purpose of the meeting. 
 
In addition the name of the meeting entered will be used as the filename the meeting will be saved to.  
Please refer to Minute Minder File List. 

Meeting Date & Time 
The Set button within Date/Time allows you to select the date and start and finish time of the 
meeting.   
 

The Start and Finish time and Date of the meeting are 
entered as follows: 

 

1. Select the start time by altering the hour, minutes and 
AM/PM elements of the Start time. 

2.  Select the date you wish to hold the meeting by 
changing the date elements of the Date field or use 
the dropdown calendar control to select a date. 

3. Select the finish time by altering the hour, minutes 
and AM/PM elements of the Finish time. 

4. Press OK to close the Meeting Time dialog.  The 
date/time of the meeting will be reflected in the 
Setup Meeting dialog. 

 

 
The Start and Finish times of the meeting can be altered by selecting the element of the time that 

requires changing (e.g. the Hour part of the field) and either using the  buttons to advance the time 
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element forwards or backwards, or, using your preferred IME device e.g. Keyboard or Block 
Recogniser to make time alterations. 
     
The Date of the meeting can be altered by selecting the element of the date that requires changing (e.g. 
the Day part of the field) using your preferred IME device e.g. Keyboard or Block Recogniser. 
 
Alternatively the Date can be altered by the selecting the dropdown calendar control.  This powerful 
control provides multiple ways of selecting the desired date.  
 
 
 
 
 

 

Advance one month 

Today’s Date 
Selected Date 

Regress one 
month 

Click to 
advance or 
regress whole 
years 

Click to select 
a specific 
month 
 

 
 
Clicking on a day within the calendar control will result in the calendar closing and the meeting date 
field being updated with the date you selected. 

 
If creating a meeting to run from 10:45 AM to 11:15 AM on the 18th July 2005 our Meeting Time 
dialog would look as follows:  
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 The date format that dates will be displayed is controlled by the default date format set 
for your mobile device. 

 
Entries into the Meeting Time dialog will be validated to ensure a date has not been selected that has 
already passed and that the finish time is not before the start time.  If either of these conditions are 
true then the dialog will remain open until these validation conditions have been satisfied. 

Inviting Meeting Attendees Using Contacts 
Having determined the date and time for the meeting the next step is to choose mandatory and 
optional attendees.  From the Setup Meeting dialog select the Choose… button.   A dialog similar to 
the one below will be displayed. 
 

 
 

 
This dialog provides a list of all Contacts stored within the mobile device.  If your mobile device has 
been set to synchronize with Microsoft Outlook Contacts then this will also display all the Contacts 
stored within Outlook. 
 
Each contact has two checkboxes beside their names, Req indicates that the person is Required to 
attend the meeting, Opt indicates the contact be invited as an Optional attendee.  
 
When the meeting invite is sent (See Booking the Meeting) all contacts for whom the Req checkbox 
has been set will receive a Calendar invite requesting them to attend the meeting.  All contacts whose 
Opt checkbox has been set will receive a Calendar invite requesting them to attend the meeting as an 
optional attendee.  Required or Optional attendees are signified by the body text of the meeting invite. 
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Attendees for a meeting are selected as follows: 
 

1. If a proposed attendee is to be a mandatory invitee to 
the meeting then the Req checkbox should be 
checked. 

2. If a proposed attendee is to be an optional invitee to 
the meeting then the Opt checkbox should be 
checked. 

3. If an invitee does not appear within this list then use 
the Other button to add additional attendees.  (See 
below.) 

4. Checking the Only show selected contacts 
checkbox will filter all contacts that have not been 
selected as a required (Req) or optional Opt) 
attendees.  This checkbox allows easy viewing of who 
has been invited to the meeting. 

 
 
The Req and Opt checkboxes are mutually exclusive given a meeting attendee cannot be a mandatory 
attendee and an optional attendee.  As either the Req or the Opt checkboxes are selected then the 
other checkbox is greyed indicating that it cannot be altered.  To reverse the selection firstly uncheck 
the checkbox that has been selected, this action will result in both checkboxes being available for 
selection. 
 
Contacts can be located by using the vertical scrollbar (if you have more than one page worth of 
Contacts) or using the alphabetical buttons at the top of the display.  Each press of these buttons will 
display names starting with the corresponding letter.  For example pressing the lmn button once will 
display all names beginning with “l”, pressing lmn again will selected all names starting with “m”.  
Finally selecting the button a third time will result in all names being displayed that start with “n”.  A 
forth press of the button will restart the cycle by selecting all names starting with “l”. 
 

 Minute Minder uses the persons name and email address to provide a unique reference point 
to the person selected.  If you have a two Contacts or Attendees added via Other with the 
same name and email addresses (or no email addresses) Minute Minder will inform you that a 
duplicate Contact has been selected.  In this situation deselect one of the duplicate entries to 
continue. 
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Inviting Meeting Attendees Who Are Not In Contacts 
If there is a person not listed in the Contacts list who you wish to invite to the meeting then the Other 
button should be used on the Attendees dialog.   
 

To enter an invitee who is not listed in Contacts: 
 

1. Press the Other button on the Attendees dialog. 

2. Name allows entry of the invitee’s name.   

3. Use Job Title to optionally describe their role within 
an organisation. 

4. Department provides optional entry to describe the 
department the person works for within an 
organisation. 

5. Company describes the organisation they work for. 

6. Work tel provides optional entry of the person’s 
telephone number. 

7. E-mail allows entry of the persons email address.  
This email address will be used when the meeting 
invite is sent, and therefore is important to be entered 
correctly.  

8. The Add To Contacts button will save the details 
entered to your mobile device to Contacts and close 
the Other dialog.   Alternatively pressing OK will 
add this attendee to your list of invitees without 
saving the details to Contacts. 

 
 
 
The name of the person you have just created will appear on the list allowing you to invite this person 
to the meeting. 
 

 Minute Minder uses the persons name and email address to provide a unique reference point 
to the person selected.  If you have a two Contacts or Attendees added via Other with the 
same name and email addresses (or no email addresses) Minute Minder will inform you that a 
duplicate Contact has been selected.  In this situation deselect one of the duplicate entries to 
continue. 

 
 
Each Contact will have an icon displayed beside each person’s name. 
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 Indicates that the person exists within Contacts and has one email address 

associated with its entry. 
 Indicates that the person exists within Contacts and has more than one email 

address associated with its entry.  By default the first populated email field will be 
used by Minute Minder in precedence order email1, email2 or email3.  Alternatively 
a choice can be made as to which email address should be used for the purposes of 
sending the meeting invite. 
 
To make this selection click and hold on the person’s name, this will result in a 
menu of available email addresses being displayed allowing the user to select one of 
the email addresses.  Having made this selection the icon will change to show 
either a ,   or  indicating whether email, email2 or email3 is used 
respectively.  
 
Making no selection will assume the email address stored in the email field. 

 Indicates that the person exists within Contacts however the Contact has no email 
address associated with its entry.  If selected this Contact will need to have an email 
associated with its entry in order for the intended attendee to be invited to the 
meeting. 

 Indicates that the person does not exist within Contacts but instead has been added 
using the Other button.  See below. 

 Indicates that the person does not exist within Contacts but instead has been added 
using the Other button however no email has been provided.  See below. 

 Indicates that the person does not exist within Contacts and has been created 
automatically as this is the Owner of the mobile device.  See Minute Minder 
Options. 

 Indicates that the person does not exist within Contacts and has been created 
automatically as this is the Owner of the mobile device however no email 
information is available for this person.  See Minute Minder Options. 

 
 

 In order for Minute Minder to successfully send the Calendar invite, all contacts 
included in the meeting invite must have a valid email address.  Attendees who do not 
have an email address, or who have an invalid email address, will not receive an 
invitation to the meeting. 

 
 
When all required and optional attendees have been selected click on the OK button to save the 
attendee invites and return to the Setup Meeting dialog.  The Setup Meeting dialog will display the 
number of Required and Optional attendees you have created for your meeting. 
 

 If additional attendees decide to join the meeting there is an opportunity of creating 
new attendees from the Minutes dialog.  See Taking the Minutes chapter. 

- 33 - 



Minute Minder 

Creating a Meeting Agenda 
We have now determined the title for our meeting, selected a date and time for the meeting and 
chosen who we wish to invite.  The next step is to create Agenda items for the meeting.   
 
Minute Minder allows you to create agenda items, associate these agenda items to an owner and 
optionally specify how long the agenda item should be discussed in the meeting. 
 
To create Agenda items select Set… from Agenda of the Setup Meeting dialog, the following dialog 
will be displayed. 
 

 
 
This dialog not only allows creation of agenda items with associated owners and times but also allows 
choice of the sequencing of Agenda Items. 
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To create agenda items: 

1. Select Add from the Agenda dialog to present the 
Agenda Details dialog 

2. Enter the subject of the Agenda item into Item 
Name. 

3. Optionally select a speaker for this agenda item from 
the Speaker list.  Only people selected as Attendees 
of the meeting will appear in this list as these will be 
notionally the only people attending your meeting. 

4. Optionally select or enter a time allocated to this 
agenda item using the Time (minutes) field.  

 

 

 

 

 

 

5. On completing your agenda item creation, select OK 
to close the Agenda Details dialog.  Your Entry will 
be appended to the Agenda list.   

6. Repeat the steps above until all Agenda Items have 
been created. 
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Removing Agenda Items 
 

To remove agenda items: 

1. Click on the Agenda item you wish to remove from 
the Agenda list.  

2. Press the Delete button to permanently delete the 
selected Agenda item.  The Agenda item will be 
removed from the Agenda list. 

 
 
Using the example above agenda item Launch will be removed from the meeting schedule. 
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Modifying Agenda Items 
Having entered our agenda items it is likely you may wish to revisit some of these agenda items to 
make amendments. 
 

To modify agenda items: 

1. Click on the Agenda item you wish to edit using the 
agenda list. 

2. Press the Edit button to open the Agenda Details 
dialog.  The dialog will be automatically populated 
with the item you chose to edit.  

3. Use the Item Name, Speaker and Time (minutes) 
fields to make the necessary adjustments to the 
selected Agenda Item. 

4. Use the OK button to save the changes or 
alternatively press Cancel to dismiss the changes. 
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Determining Agenda Item Order 
It is possible that the order in which Agenda Items have been entered into Minute Minder is not the 
order by which the meeting should be conducted.  Minute Minder provides Up and Down buttons to 
facilitate altering the sequence of agenda items. Using our example above it transpires that Andy 
Bowen needs to leave the meeting early and has therefore requested that his Docs agenda item be 
moved to the beginning of the meeting. 

 
 

To change Agenda the order: 

1. Click on the Agenda item you wish to move either up 
or down the agenda list. 

2. Use the Up button to move the item up one in the 
Agenda list.  When the Agenda items reaches the top 
of the list this button will set to unavailable. 

3. Use the Down button to move the item down one in 
the Agenda list.  When the Agenda items reaches the 
bottom of the list this button will set to unavailable. 

   

 

 
To move the Docs agenda item to be the second agenda item within our meeting, click on Docs 
within the agenda list and then press the Up button twice. 
 
Once all agenda items have been created and the sequencing determined then press OK to save 
changes.  On saving the changes Minute Minder will verify the total time for all agenda items does not 
exceed the duration of the meeting.  If the total agenda items exceeds the meeting time then a warning 
message will be presented inviting the user to either extend the meeting time to accommodate the 
agenda items or allow the user to adjust the agenda item times to fit the meeting time.   
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Booking the Meeting         5 
 
 
 
 
 
 
 

 
Having created our Meeting the next step in the process is to book the meeting by 
sending out calendar invites to our Required and Option attendees. 
 
This chapter guides you through the simple steps of sending meeting Invites. 
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Booking the Meeting. 
Having created a title, chosen a time for, selected attendees and created an agenda for the meeting the 
next step in the process is to Book the meeting by sending out a meeting invite. 
 
The act of booking the meeting will place a Calendar invite in each attendees Inbox for them to accept 
or decline.  The content of the Calendar invite will contain: 
 

• A list of all the Attendees of the meeting 
• The Date/Time the meeting is scheduled for. 
• The Agenda with Speakers and Times. 

 
Before booking the meeting ensure you have chosen the correct attendees, selected the correct 
date/time and created all the agenda items and placed them in the correct sequence.   
 
Finally ensure that each of your attendees has a correct email address associated with them.  It will be 
this email address that is used to send the meeting booking.  (Refer to Creating A Meeting) 
 
 

To Book the meeting invite: 

1. Select Book from the Tools menu of the Setup 
Meeting dialog. 

2. A confirmation prompt will be presented to ensure 
you wish to send the meeting invite.  Press Yes to 
send the meeting invite or No to abandon the 
Booking. 
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Minute Minder will use ActiveSync to post the meeting invite.  The invite for the meeting will appear 
within each attendees Inbox as follows (Microsoft Outlook client used as an example):  
 

 
 
 
The meeting will be booked to each attendees Calendar as follows (Microsoft Outlook client used as 
an example): 
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The Calendar invite will provide all the necessary details about the scheduled meeting in order for an 
attendee be fully prepared to attend and contribute to the meeting. 
 

 
 
Simply press Accept to confirm you will be attending the meeting or Decline to reply back to the 
sender that you will not be able to attend.   
 
You have now created your meeting and booked it with your colleagues.  You are now fully prepared 
and you have primed your colleagues as to the purpose of the meeting and who will be attending. 
 

 When the meeting is booked, there is currently no programmatic way of setting an 
attendee as Optional within a Calendar invite as this flag is not accessible on the mobile 
device.  Instead Optional Attendees will be flagged as optional in the body text of the 
meeting invite.  
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Taking Meeting Minutes        6 
 
 
 
 
 
 

 
It is very rare that meetings are conducted at the speed by which minutes can be 
taken.  Minute Minder provides an efficient mechanism for recording minutes 
against agenda items.  It is also recognised that often minutes need to be revisited to 
add additional details.  Minute Minder provides a sophisticated navigation 
mechanism to navigate through previously taken minute notes or skip to notes to 
complete agenda items.  
 
This chapter guides you through the process of taking minutes within a meeting, it 
describes the process of entering minutes against a given agenda item and describes 
the process of navigating through previously taken minutes. 

- 43 - 



Minute Minder 

Having successfully scheduled our meeting we are now ready to take minutes within the meeting.  
Select Minutes from the Edit menu.  You will be presented with a dialog similar to the following: 
 

 
 

The following sections describe the main controls on this dialog and their usage. 

Agenda Items & Contributors 
The Agenda Item dropdown list contains all the agenda items we scheduled for our meeting and the 
sequence in which they will be discussed within the meeting. 
 
New Agenda items can be created from the Agenda Item dropdown list.  See Creating New Agenda 
Items and New Contributors. 
 
The Contributor dropdown list contains a list of all mandatory and optional attendees associated with 
the meeting.  By default the Contributors name will default to the Speaker of the Agenda item that we 
created in the Creating Meetings chapter.  The Contributors name can be overridden by selecting 
another person from the Contributor list. 
 
Additional Attendees may attend the meeting than were originally invited.  It is often important to 
record who attended the meeting for later reference.  In order to avoid having to revisit the Meeting 
Setup screen Minute Minder provides a shortcut facility for you to add additional Attendees using 
<new> from the Contributor dropdown list of the Minutes Screen.  See Creating New Agenda Items 
and New Contributors. 
 
 
 
 

- 44 - 



Minute Minder 

Minute Categories 
The Type dropdown list details the type of minute being taken; there are three categories to choose 
from: 
 

Minute 
Type 

Description  

Action A minuted item should be marked as Action when a task is placed upon a 
person.  An Action usually has associated with it a time by which the Action 
should be completed.  For more details on setting the completion time on 
an Action please refer to the Due button below.  An example of an Action 
might be: 
 
Gary Jarvis to complete first draft of Documentation by 26th July  
 

Comment A Comment provides a record of something someone has said in a meeting.  
An example of a Comment might be: 
 
Gary Jarvis stated that the Import chapter of the product is now complete. 
 

Decision A Decision provides a record of where consensus was agreed around a 
particular item being discussed.  An example of a Decision might be: 
 
The project team agreed that the product needs to be released by Christmas if we are not 
going to miss market opportunity. 
 

 

- 45 - 



Minute Minder 

Navigating Minuted Items 
While it would be nice to imagine that meetings followed the sequence of agenda items created prior 
to the meeting, in reality this typically is not the case.  It is not uncommon that Agenda items will be 
discussed out of order and/or revisited many times during the meeting.  Minute Minder provides a 
series of powerful navigation buttons to guide you through previously taken minutes. 
 
The navigation buttons provide a quick and easy method allowing access to previously entered minutes 
records.  Consider that the following sequence of Minutes have been taken against the following 
agenda: 
 

1. Schedule 
2. Docs 
3. Dev 
4. QA 
5. AOB 

 
Sequence of 
Minutes 
Recorded 

Minute Text Agenda 
Item 

Contributor Type 

1 Code Complete 2 weeks behind 
schedule. 

Schedule Gary 
Jarvis 

Comment

2 QA complete 3 weeks behind 
schedule due to illness  

Schedule Heidi 
Lee 

Comment

3 Documentation sent to 
translators 

Docs  Andy 
Bowen 

Comment

4 Documentation now adheres to 
the new style guide. 

Docs  Andy 
Bowen 

Comment

5 Documentation expected to be 
3 weeks ahead of schedule 

Schedule Andy 
Bowen 

Comment

6 QA have 250 bugs to recheck 
as a result of developer bug 
fixing 

QA  Heidi 
Lee 

Comment

7 All automated testing has 
been completed. 

QA Heidi 
Lee 

Comment

8 Scaleability testing cannot 
start until Code Complete 
has been declared 

QA  Heidi 
Lee 

Comment

9 Launch party preparations 
are underway 

AOB Gary 
Jarvis 

Comment

10 Forgot to mention I will be 
on vacation for the next two 
weeks 

QA  Heidi 
Lee 

Comment

  
The following describes the action of the navigation buttons using the above minute sequence as an 
example of each navigation buttons use. 
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 Action Examples(s) 
 
 

 

Moves to the next minute note in the 
sequence of the current agenda item. 
  
If on the last available minute note 
within any given agenda item, this 
button will be unavailable. 

If on minute note 2 pressing  will move to 
minute note 5 as the next available note on 
Schedule was entered as note 5 

 
 

 

Moves back to the previous minute 
note in the sequence of the current 
agenda item. 
  
If on the first available minute note 
within a given agenda item this button 
will be unavailable. 

If on minute note 4 pressing  will move 
back to minute note 3 as this minute note is 
the previously recorded minute note against 
Docs 

 
 

 

Moves to the last minute note of the 
next Agenda item.  The next agenda 
item is governed by the order in the 
Agenda Item dropdown list. 
  
If the next agenda item has no minute 
notes associated with it then a new 
note will be presented for this agenda 
item.  If no text is entered against this 
note and a new note is navigated to 
then this note will not be saved. 
  
If on the last agenda item then this 
button will be unavailable. 

Example 1  If on minute note 1 pressing  
will move to minute 4.  This is governed by 
the fact that Docs is the next agenda item 
after Schedule and minute 4 is the last 
recorded minute note against Docs. 

Example 2  If on minute note 4 pressing  
will present a new minute record for Dev.  
This is determined by the fact that Dev is 
the next agenda item after Docs however 
given no minutes notes have been created for 
Dev then a new record is presented for 
minute entry.  This note will only be saved if 
text is entered into the notes area of this 
record. 

 
 

 

Moves to the last minute note of the 
previous Agenda item.  The previous 
agenda item is governed by the order in 
the Agenda Item dropdown list. 
 
If the previous agenda item has no 
minute notes associated with it then a 
new note will be presented for this 
agenda item.  If no text is entered 
against this note and a new note is 
navigated to then this note will not be 
saved. 
 
If on the first agenda item then this 
button will be unavailable. 

Example 1  If on minute note 9 pressing  
will move to minute 10.  This is governed by 
the fact that QA is the previous agenda item 
before AOB and minute note 10 is the last 
recorded minute note against QA. 
 

Example 2  If on minute note 7 pressing  
will present a new minute record for Dev.  
This is governed by the fact that Dev is the 
previous agenda item before QA however 
given no minutes notes have been created for 
Dev then a new record is presented for 
minute entry.  This note will only be saved if 
text is entered into the notes area of this 
record. 
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Moves to the last minuted note of the 
last agenda item. 
 
If on the last minute note of the last 
agenda item or there are less than two 
minute notes then this button will be 
unavailable. 

If on minute note 4 pressing  will move to 
minute note 9 which is the last minuted item 
of the last agenda item. 

 

 
 
 

Moves to the first minuted note of the 
first agenda item. 
 
If on the first minute note of the first 
agenda item or there are less than two 
minute notes then this button will be 
unavailable. 

If on minute note 4 pressing  will move to 
minute note 1 which is the first minuted item 
of the first agenda item. 

 

New and Due 
The New button creates a new minute note.  By default the agenda item for the previous minute note 
will be used as the default agenda item for the new note however this can be overridden by simply 
selecting an alternative agenda item from the Agenda Item dropdown list. 
 
The New button will append a new note at the end of the current agenda item. 
 
The Due button allows a date to be entered against an agenda item.  A Due date can only be recorded 
against Action agenda items to indicate the target date the action is to be completed.  On entering a 
Due date a calendar control the same as that described in Chapter 5 will be presented. 

Note Text 
The text box provides an area to record minuted text for any given agenda item.  Text is entered using 
your preferred IME data entry devices. 
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Adding Minute Notes 
 

To enter a new minute: 

1. Click on the New button, this will present a new 
minute record for data entry. 

2. Select the Agenda Item the minuted note refers to if 
it is different to the default one displayed.  

3. Select the Contributor who provided the minute 
information within the meeting if it is different to the 
default one displayed. 

4. Select the Type to indicate whether the minute refers 
to a Comment, Decision or an Action. 

5. If the Type refers to an Action optionally select a 
Due date the action is to be completed by. 

6. Finally enter the text that represents the minute into 
the text field. 

7. To save the minuted note either click on OK to close 
the Minutes dialog, press New to enter a new record 
or navigate to a previously minuted note using the 
navigation buttons. 
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Modifying Minute Notes 
It is not uncommon for previously minuted items to be revisited to remind attendees of the meeting 
what was said or to add or amend information. 
 

To modify a previously entered minute note: 

1. Use the navigation button to locate the minute note 
that requires modification.  Refer to Navigating 
Minuted Items. 

2. The Minutes dialog will be populated with the 
details of the minuted item displaying the Agenda 
Item, Contributor, Type and Minuted Text. 

3. Make alterations to the Agenda Item, Contributor, 
Type and Minuted Text fields as required.  

4. To save the minuted note either click on OK to close 
the Minutes dialog, press New to enter a new record 
or navigate to previously minuted note using the 
navigation buttons. 

   

 

 

 If altering the Agenda Item for a previously taken minute it should be noted that the 
order by which the minuted note will be navigated using the navigation button will 
change.   Refer to Navigating Minuted Items. 

Manipulating Notes Text 
The Edit menu provides a number of options to manipulate the notes text.  These options again assist 
in fast note taking which is essential in a meeting notes taking environment.  The following table 
provides details on the functionality of each Edit menu option. 
 
Edit menu 
option 

 
Functionality 

Undo Undoes any previous data entry in the text of the minute note. 
Redo Reapplies what was previously undone with Undo. 
Cut Cut is only available when text has been highlighted.  Cut will remove the 

selected text from the note and save it to the clipboard. 
Copy Copy is only available when text has been highlighted.  Copy saves the selected 

text to the clipboard.  Unlike Cut the text is not removed from the meeting 
note. 

Paste Paste is only available when there has been something saved to the clipboard 
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either via using Cut or Paste from Minute Minder or via another clipboard 
compliant application.  Paste will insert the text within the clipboard into the 
text from the position of the cursor within the Notes text.  

Clear Clear will remove all text from the notes text. 
Select All Select All will highlight all Notes text.  This is a useful feature if you want to 

copy the contents of one Note to another if used in conjunction with Copy. 
Find/Replace Find will prompt the user to enter some text to find within the Note.  On 

selecting OK you will be able to step through all occurrences of that text.  This 
operation will apply to all Notes entered. 
 
Replace will prompt the user to enter some text to find within the Note and 
some text to replace it with.  On selecting OK all occurrences of the find text 
will be replaced by the replace text.  This operation will apply to all Notes 
entered. 

 

Saving New and Modified Minute Notes 
To facilitate ease of use Minute Minder is set to be in a permanent editable state.  What this means is 
that as a previous entered minute note is navigated to the note is available to be edited.  As the user 
closes the Minutes dialog, presses the New button or navigates to a different note then this action 
will automatically save the current note.  
 
Similarly if a new minute note is entered using the New button then this note is automatically saved as 
the Minutes dialog is closed or a previous note is navigated to.  The only exception to this rule is if no 
minute text is entered against a note in which case the note will be discarded as the dialog is closed or a 
previous record is navigated to.  
 

 Notes can be removed from the system by removing all the text of a note and then 
navigating away from that note. 
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Creating New Agenda Items and New Contributors 
It is not uncommon for new agenda items to be raised during meeting or on occasions additional 
attendees attend the meeting.   It is important to have a means of creating these new items quickly 
from within Minute Minder without having to exit the notes taking screen.  
 

To create a new Agenda Item from the Minutes 
dialog: 

1. Select <new> from the Agenda Item dropdown 
list. 

2. The Agenda Details screen will be presented for 
you to append a new agenda item to the meeting. 

3. Enter the subject of the Agenda item into Item 
Name. 

4. Next select a speaker for this agenda item from the 
Speaker list.  Only people selected as Attendees of 
the meeting will appear in this list as these will be the 
only people attending your meeting. 

5. Optionally select or enter a time allocated to this 
agenda item using the Time (minutes) field.  

6.  Use the OK button to save the changes or 
alternatively press Cancel to dismiss the changes. 

 

NOTE1: If the new Agenda Item is to be associated with a 
person who was not originally invited to the meeting then 
this person will need to be added as a Contributor before the 
new agenda item is created.  (See below). 

 

NOTE2: If you are currently editing a note, e.g. you have 
some notes text associated with the note then selecting 
<new> agenda item will effectively change the agenda item 
for that note.  If this is not what is desired then the New 
button must be used to create a new note prior to using the 
<new> option in the agenda item list. 
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To add an additional Contributor to the meeting 
from the Minutes dialog: 

1. Select <new> from the Contributor dropdown list. 

2. The Attendees screen will be presented for you to 
select a new Attendee. 

3. Select either the Req or Opt checkboxes to add new 
attendees to the meeting. 

4. If an invitee does not appear within this list then use 
the Other button to add additional attendees.  (Refer 
to section of 'Creating a Meeting' chapter) 

5. Use the OK button to return to the Minutes screen.  
If additional Attendees were selected then these will 
appear in the Contributor dropdown list of the 
Minutes screen.   

 

NOTE1: If you are currently editing a note, e.g. you have 
some notes text associated with the note then selecting to 
create a <new> contributor will effectively change the 
contributor for that note.  If this is not what is desired then 
the New button must be used to create a new note prior to 
using the <new> option in the Contributor list. 
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Distributing Meeting Minutes       7 
 
 
 
 
 
 
 

 
This chapter details how meeting minutes recorded within Minute Minder can be 
distributed to all Attendees of the meeting.  The minutes will automatically be 
processed into formatted minutes using the output preference and template supplied 
within Tools Options. 
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Steps Performed As Part Of The Distribute Process. 
One of the powerful features of Minute Minder is its ability to automatically generate formatted 
minutes from the minute notes taken in the meeting.  No longer do you need to spend hours trying to 
read your hastily scribbled notes from the meeting and re-entering these into a word processor in 
order to produce formatted minutes.  A simple selection of a menu item in Minute Minder will 
generate these minutes for you and distribute them to all attendees of the meeting. 
 

 
To Distribute the Minutes: 

1. Select Distribute from the Tools menu from the 
Setup Meeting dialog. 

 

 

 

 

 

 

 

 

2. A prompt will be displayed informing the user the 
minutes have been generated and saved to the 
mobile device.  A question is then asked if you wish 
to send the minutes at this time or defer the sending 
to a later time.  Select Yes to send the minutes or No 
to defer the send operation.  If the user chooses to 
send the minutes then all attendees of the meeting 
will be sent the minutes as a mail attachment.  
Minute Minder will inform the user when the 
minutes have been sent.  
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Completing the above operation will perform the following actions: 
 

• The Output format (RTF or Plain Text) and the Template (RTF only) selected in Tools 
Options will be used to generate the formatted minutes.  All information created in the 
process of creating the meeting and recording the minutes will be pushed through the template 
to produce formatted minutes.  The minutes file created by the template will be stored in My 
Device\Program Files\Raspberry Software\Minute 
Minder\Output\.  The generated minutes file name will be the same name as the file 
that stored the meeting minutes but instead of having an .RSM file extension the file will have 
a .RFT or .TXT file extension depending on the output format selected by the user.  The 
output directory provides the user an opportunity to review the minutes file before sending out 
the minutes.  This file can either be viewed on the mobile device or via copying the file to the 
PC to review.   

 

 Amendments to the meeting minutes should be made by editing the minute notes using 
Minute Minder on the mobile device as this forms the master version of the minutes.  
When the Minutes are later regenerated and sent then all alterations will be honoured. 

 For more information regarding the format of the created minutes please refer to 
Chapter 10 Customizing Templates. 

 
• Once the formatted minutes have been created and the user requests to send the minutes an 

email will be created with the formatted minutes attached.  This email will be sent to everyone 
who was invited to the meeting.   

 

 If the Tools Distribute option is executed more than once then the old output minute 
file generated in the Output directory will be overwritten by the new version.  

 
 

- 56 - 



Minute Minder 

An example of the email sent by Minute Minder is as follows: 
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An example of the formatted minutes attachment is as follows: 
 

Start 
Company Confidential 

 
 
Minutes from the Project Progress Meeting held on Monday, July 18, 2005 at 10:45 AM 
and scheduled for 30mins. 
 
Those asked to attend the meeting were as follows: 

Name Required 
1. Andy Bowen Required 
2. Bob Holt Required 
3. Diane Fish Optional 
4. Gary Jarvis Required 
5. Heidi Lee Required 
6. Simon Hopper Required 
  

 
The agenda set for the meeting was as follows: 

Item Sponsor Time 
Allowed 

1. Schedule Gary Jarvis 10 
2. Docs Andy Bowen 10 
3. Dev Bob Holt 10 
4. QA Heidi Lee 15 
5. AOB  5 
   

 
Minutes 

  
Item. 
Type 

Speaker Note Due Date 

1.C Gary Jarvis 
10:20:54 AM 

Schedule 
Code Complete 2 weeks behind 
schedule. 

 

2.C Heidi Lee 
10:22:33 AM 

QA complete 3 weeks behind 
schedule due to illness 

 

3.C Andy 
Bowen 
10:25:56 AM 

Documentation expected to be 3 
weeks ahead of schedule 

 

4.C Andy 
Bowen 
10:27:00 AM 

Docs 
Documentation sent to 
translators 

 

5.C Andy 
Bowen 
10:30:10 AM 

Documentation now adheres to 
the new style guide. 

 

6.C Heidi Lee 
10:35:31 AM 

QA 
QA have 250 bugs to recheck as 
a result of developer bug fixing 

 

7.C Heidi Lee 
10:36:36 AM 

All automated testing has been 
completed. 
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8.C Heidi Lee 
10:40:38 AM 

Scaleability testing cannot start 
until Code Complete has been 
declared 

 

9.C Heidi Lee 
10:43:38 AM 

Forgot to mention I will be on 
vacation for the next two weeks 

 

10.C Gary Jarvis 
10:45:27 AM 

AOB 
Launch party preparations are 
underway 

 

    
 
This file 'Project Progress Meeting.rtf' was generated from 'Project Progress Meeting.rsm' on 
Friday, March 11, 2005, 11:25 AM. 

 
End 
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Quick Import           8 
 
 
 
 
 
 

 
Ever attended a meeting where at the last minute you have been volunteered to take 
the minutes?  More often than not you scrabble for you notepad and struggle to 
record the attendees names as well as note take as the meeting gets into full swing. 
 
With Minute Minders “Quick Import” feature this is not longer an issue.  Quick 
Import provides a facility for you to Import the current or next meeting from your 
calendar into Minute Minder. 
 
This chapter guides you through this simple but powerful feature of Minute Minder. 
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The Quick Import feature will create a new Minute Minder meeting by importing all the details it can 
from the current or next calendar appointment on your mobile device.  This functionality provides a 
quick start to any meeting and avoids duplicated effort in entering data into Minute Minder that 
already exists elsewhere on your mobile device. 
 
The Calendar appointment subject will be used as the title for the meeting.  In addition all the invitees 
to the Calendar appointment will be imported into the imported meeting.  
  
Imagine your Calendar looks as follows: 
 

 
 
Notice the time is 12:50, our Project Progress Meeting has passed and our next appointment is at 
16:00, Docs Review Meeting.  Imagine you have been requested to take minutes in this meeting.  
Quick Import allows you to prepare for minute taking for this next appointment. 
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To Import the next Calendar appointment into 
Minute Minder: 

1. Select Quick Import from the Tools menu from the 
File List screen. 

2. Minute Minder will determine the current or next 
appointment and provides a Yes/No dialog 
requesting whether this meeting should be imported. 

3. Selecting No will abort the import process and 
return back to the File List Dialog. 

4. Selecting Yes will create a new meeting. 

• The Subject of the Calendar appointment will be 
imported into the Meeting Title field. 

• The Date and Time of the Calendar appointment 
will be imported into the Date, Start/Finish time 
of the meeting.  

• The Attendees in of the Calendar appointment 
will be imported as Attendees of the meeting. 

 

 

 

 
Once imported, the meeting can then be modified to create agenda items in readiness for the meeting. 
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Minute Minder Options        9 
 
 
 
 
 
 
 

 
This chapter details the settable options from within Minute Minder. 

- 63 - 



Minute Minder 

Settable Options 
The Options setting within Minute Minder allows the user to set their preferred file format when 
distributing the meeting minutes and set whether the owner should be added as a default attendee 
when creating new meetings. 
  

 
To change the Options within Minute Minder: 

1. Select Options… from the Tools menu from the 
File List screen OR select Options… from the 
Tools menu from the Setup Meeting screen. 

2. Use the Export Format: dropdown list to choose 
between distributing minutes as RTF format or Plain 
Text. 

3. If RTF format has been selected then you can 
optionally select the Template Name you wish the 
output to be produced in the style of. 

4. Finally check the Always Include Owner checkbox 
if you wish Minute Minder to automatically create 
the owner of the device as an attendee of the 
meeting.  If this checkbox is unchecked then the 
owner of the mobile device will not automatically be 
created as an attendee of new meeting.   

 
 
RTF stands for Rich Text Format and is a format supported by Microsoft Word and Microsoft  
Wordpad (available on most operating systems).  As the name implies RTF allows text to be formatted 
to produce rich output.  The types of formatting supported include: 

• Bold/Italic/Underline 
• Colours 
• Tables 
• Fonts & Sizes 

 
Plain Text supports no formatting characteristics and supports only fixed width fonts.  The advantage 
of using Plain Text over RTF is that the files produced are ASCII and hence can be read by many 
applications. 
 
One Template is provided with Minute Minder that produces well formatted minutes.  Minute Minder 
provides a powerful means of adding your own Templates to suit different situations.  Refer to 
Customizing Templates within the Distributing Meeting Minutes chapter. 
 
The options set are global and hence apply to all Minute Minder files that are opened. 
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If the Always Include Owner option is checked then the Name and Email address of the mobile 
device is read from Owner Information (Start Menu, Settings, Owner Information) and used to create 
an automatic attendee when new meetings are created.  The owner of the meeting is denoted by a 
green icon in the Attendee list if the owner is not already in Contacts in which case it will align to 
Contacts. 
 
This option is useful as by default the creator of the meeting is not created as an attendee and 
therefore would need to be explicitly included as an Attendee by selecting them from Contacts or 
creating them as an Other attendee. 
 
This option has no effect when creating a meeting via Quick Import as in this situation the owner of 
the meeting is automatically read from Calendar invite. 
 

 If the mobile Device Owner Information contains no data in the Name field then not 
attendee is automatically created. 

 
 

 The Owner Information is read in by Minute Minder at the point Minute Minder is 
started.  If you change the Owner Information be sure to stop Minute Minder from 
running in memory in order for it to recapture the new Owner information the next 
time it is started. 
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Customizing Templates       10 
 
 
 

 
By default Minute Minder ships with one predefined Minutes Template, Standard.rtf.  
However a sophisticated template generation process is available to allow users to 
create their own customized templates in order to use different output templates to 
suit different situations.  This chapter guides you through the process of creating the 
templates. 
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The format the Minutes are created in is determined by the Template file currently selected within the 
Tools Options menu (See Minute Minder Options chapter).  By default Standard.rtf is used within 
Minute Minder, however, this chapter guides you through creating your own custom templates. 
 
Minute Minder provides a mechanism for users to create their own Template files.  For example the 
format of minutes produced for a Rugby Club AGM might be different to the format required within 
a Business Meeting. 
 
Template files contain a number of tags that signify the data to be output within the formatted 
Minutes document.  These tags can be formatted to create a rich Minuted Output document.  
 
New Templates must be produced as .RTF files (supported by Microsoft Word and Microsoft 
Wordpad).  Once created these files must be uploaded to the Templates directory of the Minute 
Minder install.  Typically this is within the following location  
 
My Device\Program Files\Raspberry Software\Minute Minder\Templates 
 
For example uploading new Template files Legal and Informal to the above location on your 
device would present these new templates as selectable within Tools Options.   
 

 
 

 Under no circumstances should the Standard.rtf template be modified. 
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 It should be noted that if creating your Customized Template using Microsoft Word 
the RTF file created by Word may contain a number of additional pieces of 
information not visible to the user.  For example if modifying a file, change history is 
automatically added to the RTF files without the user knowing.  These automatic 
insertions into the file could cause issues within Minute Minder.   It is highly 
recommended that once the Customized Template has been created using Word it be 
opened and saved using Microsoft WordPad.  WordPad will automatically filter out the 
additional content added by Microsoft Word creating a purer RTF Template file.    

 
The remainder of this chapter will describe the generation of a new Template file and detail the Minute 
Minder tags that can be contained within it. 
 

Template Tags 
An example of a Tag within a Template file is as follows: 
 
Minutes from the ^meeting_name^ held on ^meeting_long_date^ 
 
Once invoked via the Tools Distribute option this would produce formatted minutes as follows: 
 
Minutes from the Sales Meeting held on Sunday, March 31, 2005 
 
This simple example highlights a number of rules associated with tags. 
 

1. All tags are enclosed within the an opening ^ and a closing ^ character 
2. The text enclosed within the ^ characters has to be text that means something to Minute 

Minder.  Using our example above the ^Meeting_name^ will be substituted with the text the 
user entered for the meeting title for the meeting they created.  See later in the chapter for a 
complete list of supported tags. 

3. Text that is not enclosed within ^ characters will simply be output as literal text.  Using the 
above example “Minutes from the ” and “ held on” will simply be pushed through to the 
output document preserving any formatting applied.   

 
Note the tags can be formatted as can any other text within the template file.  In the above example 
the meeting name and date have been formatted as bold.  Simply format the tag using the desired 
formatting attribute and this will be adhered to in Formatted Minute output. 

Repeating and Non-Repeating Tags 
There are two types of Tags within Minute Minder, those that repeat and those that do not. 
 
Non-Repeating tags apply to data that contains only one element of data.  An example of a Non-
Repeating tag is Meeting Name.  See example above. 
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A Repeating tag is where there are multiple instances of data for a particular tag.  Examples of 
repeating tags are Attendees or Agenda Items.  For example adding the following tag to your template 
will repeat the tag for every Attendee invited to your meeting. 
 

^attendee_list "%d. %n”^ 
 
Would produce something like: 
 

1. Andy Bowen 
2. Bob Holt 
3. Diane Fish 
4. Gary Jarvis 
5. Heidi Lee 

 
In this example the tag attendee_list denotes that we wish to output the meeting Attendees.  The tag 
Attendees_list accepts a number of parameters which determine the type of output to be generated as 
part of this tag. In the above example we have used the following parameters: 
 
     %d – nth Attendee 
     %n – Attendee Name  
 
The key concept here is the tag ^attendee_list "%d. %n”^ will repeat for every Attendee 
invited to the meeting meaning all attendees will be showed in the formatted minutes output.  

Non-Repeating Template Tag Definitions 
This section describes all the Non-Repeating tags that can be used within a Minute Minder Template.  
For each tag we describe its syntax, its meaning and an example of the output.  Refer to “Example 
Template File” to see an example of how these tags can be used.  
 
Tag Definition & Example 
^meeting_name^ 
 

The Title of the meeting as specified in the Setup Meeting dialog. 
Example:  
Minutes of the ^meeting_name^. 
 
Produces: 
Minutes of the Project Progress Meeting. 
 
Where “Project Progress Meeting” is the title of the meeting. 

^meeting_date^ 
 

The date the meeting was held in short form (format determined by 
the locale of the PDA). 
Example: 
Meeting date: ^meeting_date^ 
 
Produces 
Meeting date: 18/7/2005 
 
Where “18/7/2005” is the date set for the meeting. 
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^meeting_long_date^ 
 

The date the meeting was held in long form (format determined by 
the locale of the PDA). 
 
Example:  
Meeting date: ^meeting_long_date^ 
 
Produces: 
Meeting date: Monday, July 18, 2005 
 
Where Monday, July 18, 2005 was the date set for the meeting. 

^meeting_start^ 
 

The time the meeting was due to start (format determined by the 
locale of the PDA). 
 
Example: 
Start Time: ^meeting_start^ 
 
Produces: 
Start Time: 10:45 AM 
 
Where “10:45 AM” is the start time for the meeting. 

^meeting_length^ 
 

The duration of the meeting. 
Example: 
Meeting Duration:  ^meeting_length^ 
 
Produces: 
Meeting Duration:  30mins 
 
Where “30mins” is the scheduled duration of the meeting. 

^minute_file^ 
 

The mobile device file that the minutes were saved into during the 
meeting.  Typically this file is named after the meeting title.  It is this 
file that was used to generate the output file. 
 
Example:  
Minutes Recorded To: ^minute_file^ 
 
Produces: 
Minutes Recorded To: Project Progress Meeting.rsm 
 
 
Where “Project Progress Meeting.rsm” was the name of the PDA 
meeting file. 

^output_file^ 
 

The name of the RTF file that contains the formatted minutes. 
 
Example: 
Formatted Minutes File: ^output_file^ 
 
Produces: 
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Formatted Minutes File: Formatted Minutes.rtf 
 
Where Formatted Minutes is the name of the output file. 

^output_time^ 
 

The date and time the Formatted Minutes were generated. (format 
determined by the locale of the PDA). 
 
Example: 
Formatted Minutes Produced: ^output_time^ 
 
Produces: 
Formatted Minutes Produced: 7/18/2005 3:52 pm  

^output_long_time^ 
 

The date and time the Formatted Minutes were generated (format 
determined by the locale of the PDA).   
 
Example: 
Formatted Minutes Produced: ^output_long_time^ 
 
Produces: 
Formatted Minutes Produced: Monday, July 18, 2005 3:52 pm  
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Repeating Template Tag Definitions 
This section describes all the Repeating tags that can be used within a Minute Minder Template.  For 
each tag we describe its syntax, its meaning and an example of the output.  Refer to “Example 
Template Example File” to see an example of how these tags can be used.  
 
Within the following sections the "<parameters>" section is repeated for each occurrence of the 
repeating item. 
 
Attendees 
Tag Definition 
^attendee_list 
“<parameters>”^ 

List of attendees for the meeting. 
 

Parameters 
%d Nth item being output. 
%n Name of the Attendee 
%r Shortened “Required” (outputs as Req.) or “Optional” (outputs as 

Opt.) flag for meeting attendance. 
%R Full “Required” (outputs as Required) or “Optional” (outputs as 

Optional) flag for meeting attendance. 
%l If there was a value returned by the previous parameter, move to a 

new line before outputting the next parameter.  This parameter 
avoids throwing a linefeed unnecessarily if the last parameter 
contained no value. 

 
Example: 

Name Required 
^attendee_list "%d. %n %R 

"^ 
 
NOTE: The "^ is carried onto the next line to force each attendee onto a new line.  
 
Produces: 

Name Required 
1. Andy Bowen Required 
2. Bob Holt Required 
3. Diane Fish Optional 
4. Gary Jarvis Required 
5. Heidi Lee Required 
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Agenda List 
Tag Definition 
^agenda_list 
“<parameters>”^ 

List of agenda items for the meeting. 

Parameters 
%d Nth item being output. 
%i Agenda item name 
%n Name of the Agenda item speaker. 
%t Duration set for the agenda item. 
%l If there was a value returned by the previous parameter, move to a 

new line before outputting the next parameter.  This parameter 
avoids throwing a linefeed unnecessarily if the last parameter 
contained no value. 

 
Example: 

Item Sponsor Time 
Allowed 

^agenda_list "%d. %i %n %t 
"^ 
 
NOTE: The "^ is carried onto the next line to force each Agenda Item onto a new line.  
 
Produces: 

Item Sponsor Time 
Allowed 

1. Schedule Gary Jarvis 10 
2. Docs Andy Bowen 10 
3. Dev Bob Holt 10 
4. QA Heidi Lee 10 
5. AOB  5 
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Minute Notes 
Tag Definition 
^minutes 
“<parameters>”^ 

Output of each Minute Note for the meeting. 

Parameters 
%d Nth item being output. 
%b Body text for Minute Note 
%s Name of the item speaker for the Minute Note. 
%a Short type of Minute Note classification item.  A, C, or D meaning 

Action, comment or Decision. 
%A Long type of Minute Note classification item, Action, Comment, or 

Decision 
%i Agenda Item the Minute Note is associated with.  
%I Agenda Item the Minute Note is associated with.  Only emitted 

when the agenda item changes from the previous note.  Use of this 
parameter avoids unnecessary repeating of Agenda Items if the 
output has not changed. 

%t Due date for item in short form (format determined by the locale of 
the PDA).  Only applies to Actions which have Due dates set 
against them. 

%T Due date for item in long form (format determined by the locale of 
the PDA).  Only applies to Actions which have Due dates set 
against them. 

%x Timestamp denoting when the note was first written to (format 
determined by the locale of the PDA). 

%l If there was a value returned by the previous parameter, move to a 
new line before outputting the next parameter.  This parameter 
avoids throwing a linefeed unnecessarily if the last parameter 
contained no value. 

 
Example: 

Item. 
Type 

Speaker Note Due Date 

^minutes 
"%d.%a 

%s 
%x 

%I%l%b %t 

"^    
 
NOTE: The "^ is carried onto the next line to force each Minute Note onto a new line.  
 
Produces: 

Item. 
Type 

Speaker Note Due Date 

1.C Gary Jarvis 
10:17:00 AM 

Schedule 
Code Complete 2 weeks behind 
schedule. 

 

2.C Heidi Lee 
10:19:00 AM 

QA complete 3 weeks behind schedule 
due to illness 

 

3.C Andy Docs  
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Bowen 
10:21:00 AM 

Documentation sent to translators 

3.C Andy 
Bowen 
10:23:00 AM 

Documentation now adheres to the new 
style guide. 

 

 
 

 It should be noted that if font attributes such as colour, size, bold, underline etc. are 
applied to output parameters then these attributes must be applied to both the % and 
the parameter name as a pair.  For example: 

 
 These are permitted: 
 

%b 
%b 
%b 
 

 
 These are NOT permitted: 
 

%b 
%b 
%b 

 

 Failure to adhere to the exact tag syntax such as pairing up ^'s or not closing "'s might 
generate unexpected results.
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Example Template File 
The following is an example Template file with typical output it will generate. 
 
Template file 

Start 
 

Raspberry Software Limited 
Company Confidential 

 
Minutes of the    ^meeting_name^. 
Meeting date (Short):   ^meeting_date^ (^meeting_long_date^) 
Meeting date (Long):   ^meeting_long_date^ 
Start Time:     ^meeting_start^ for ^meeting_length^  
  
Those asked to attend the meeting were as follows: 

Name Required 
^attendee_list "%d. %n %R 

"^ 
 
The agenda set for the meeting was as follows: 

Item Sponsor Time 
Allowed 

^agenda_list "%d. %i %n %t 
"^ 
 

Minutes 
 Item. 
Type 

Speaker Note Due 
Date 

^minutes 
"%d.%a 

%s 
%x 

%I%l%b %t 

"^ "^ "^ "^ 
 
Minutes Recorded To:    ^minute_file^ 
Formatted Minutes File:    ^output_file^ 
Formatted Minutes Produced (Short):  ^output_time^ (^output_long_time^) 
 

End 
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Formatted Minutes File 
 

Start 
 

Raspberry Software Limited 
Company Confidential 

 
Minutes of the     Project Progress Meeting. 
Meeting date (Short):    18/7/2005 (Monday, July 18, 2005) 
Start Time:      10:45 AM for 30mins 
 
Those asked to attend the meeting were as follows: 

Name Required 
1. Andy Bowen Required 
2. Bob Holt Required 
3. Diane Fish Optional 
4. Gary Jarvis Required 
5. Heidi Lee Required 

 
The agenda set for the meeting was as follows: 

Item Sponsor Time 
Allowed 

1. Schedule Gary Jarvis 10 
2. Docs Andy Bowen 10 
3. Dev Bob Holt 10 
4. QA Heidi Lee 10 
5. AOB  5 

 
Minutes 

Item. 
Type 

Speaker Note Due 
Date 

1.C Gary Jarvis 
10:17:00 AM 

Schedule 
Code Complete 2 weeks behind 
schedule. 

 

2.C Heidi Lee 
10:19:00 AM 

QA complete 3 weeks behind schedule 
due to illness 

 

3.C Andy 
Bowen 
10:21:00 AM 

Docs 
Documentation sent to translators 

 

    
 
Minutes Recorded To:    Project Progress Meeting.rsm 
Formatted Minutes File:    Formatted Minutes.rtf 
Formatted Minutes Produced (Short):  7/18/2005 3:52 pm (Monday, July 18, 2005 3:52 pm) 
 

End 
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